NIST/ITL Conformance Test Suite for Patron Format A
Data Structures Specified in ANSI INCITS 398-2008,
Common Biometric Exchange Formats Framework
(CBEFF)

Beta Implementation V1.1

User Guide
August 2008

Fernando Podio, NIST/ITL, CTS Development Project Manager
Yooyoung Lee, Department of Computer Engineering,
University of Chung-Ang, Korea (NIST Guest Researcher)
Mark Jerde, ID Technology Partners (NIST Contractor)
Dylan Yaga, NIST STEP Student

National Institute of Standards and Technology (NIST)
Information Technology Laboratory (ITL)
Computer Security Division (CSD)
DISCLAIMER FOR

NIST/ITL CONFORMANCE TEST SUITE (CTS) FOR
PATRON FORMAT A DATA STRUCTURES SPECIFIED IN ANSI
INCITS 398-2008, COMMON BIOMETRIC EXCHANGE FORMATS
FRAMEWORK (CBEFF)

BETA IMPLEMENTATION V1.1
August 21, 2008

The software was developed by the National Institute of Standards and Technology (NIST), an agency of the Federal Government. Pursuant to Title 15 United States Code Section 105, works of NIST are not subject to copyright protection in the United States and are considered to be in the public domain. Thus, the software may be freely reproduced and used. Please explicitly acknowledge the National Institute of Standards and Technology as the source of the software.

This software is released by NIST as a service and is expressly provided "AS IS." NIST MAKES NO WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR STATUTORY, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NON-INFRINGEMENT AND DATA ACCURACY. NIST DOES NOT REPRESENT OR WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT ANY DEFECTS WILL BE CORRECTED.

NIST does not warrant or make any representations regarding the use of the software or the results thereof, including but not limited to the correctness, accuracy, reliability or usefulness of the software. By using this software or by incorporating this software into another product, you agree to hold harmless the United States Government for any and all damages or liabilities that arise out of such use.

Certain trade names and company products are mentioned in the text or identified. In no case does such identification imply recommendation or endorsement by the National Institute of Standards and Technology, nor does it imply that the products are necessarily the best available for the purpose. With the exception of material marked as copyrighted, information presented in this document is considered public information and may be distributed or copied. Use of appropriate byline/photo/image credits is requested.

This work was funded by NIST/ITL CSD and the NIST/ITL Identity Management Systems Program. It was funded in part by the National Institute of Justice.
Contents

1. Introduction ................................................................................................................................. 4
   1.1. Concepts on Conformance Testing ......................................................................................... 4
2. Requirements .................................................................................................................................. 5
   2.1 Configuration ........................................................................................................................... 5
   2.2 CBEFF CTS Beta 1.1 installation ............................................................................................. 5
   2.2.1 Location of the Sample Data ............................................................................................... 6
   2.2.2 Location of the Log and Report Files ................................................................................ 6
   2.3 CBEFF_CTS Removal ........................................................................................................... 6
   2.4 Starting the CBEFF CTS ....................................................................................................... 6
3. CTS Operating Instructions ......................................................................................................... 6
   3.1 CBEFF CTS Welcome Window ............................................................................................. 7
      3.1.1 Title Bar .......................................................................................................................... 7
      3.1.2 Menu Bar ........................................................................................................................ 7
      3.1.3 Log File Prefix and Log Filepath Text Boxes .................................................................. 8
      3.1.4 TestCase/Manifest/BinaryFile Editor ............................................................................. 8
      3.1.5 Test Binary Files .......................................................................................................... 8
      3.1.6 Check Test Cases .......................................................................................................... 8
   3.2 Test Case/Manifest/Binary File Editor Window ..................................................................... 9
      3.2.1 Title Bar .......................................................................................................................... 9
      3.2.2 Menu Bar ........................................................................................................................ 9
      3.2.3 Icon Bar .......................................................................................................................... 9
      3.2.4 Name (Manifest/Test Case) and Description Panel ............................................................ 13
      3.2.5 Expected Result Panel .................................................................................................. 14
      3.2.6 Fields and Binary Data Panel ......................................................................................... 14
      3.2.7 Test Panel ..................................................................................................................... 17
      3.2.8 Binary Data Panel .......................................................................................................... 18
      3.2.9 Developing Manifests, Test Cases and Binary Files ......................................................... 18
   3.3 Test Binary Files Window ....................................................................................................... 23
      3.3.1 Title Bar .......................................................................................................................... 23
      3.3.2 Menu Bar ........................................................................................................................ 23
      3.3.3 Icon bar ........................................................................................................................... 23
      3.3.4 Manifest Open panel ...................................................................................................... 26
      3.3.5 Testing Binary Files ...................................................................................................... 26
      3.3.6 Test Status Panel .......................................................................................................... 27
   3.4 Check Test Cases Window ....................................................................................................... 28
      3.4.1 Title Bar .......................................................................................................................... 28
      3.4.2 Menu Bar ........................................................................................................................ 28
      3.4.3 Icon Bar .......................................................................................................................... 28
      3.4.4 Test Case Panel ............................................................................................................. 29
      3.4.5 Test Status Panel .......................................................................................................... 29
      3.4.6 Test Case Analysis ....................................................................................................... 30
   Annex A. List of Error Messages ................................................................................................. 31
   Annex B. Test Log Displaying “All Errors” Information .............................................................. 35
   Annex C. Test Report Displaying “All Errors” Information .......................................................... 36
   Annex D. IBIA Identifiers .......................................................................................................... 37
1. Introduction

This document contains computer requirements, installation instructions and CBEFF Patron Format A Conformance Test Suite (CTS) operation instructions. Two companion documents are available: “Quick Start Guide” and “Overview”.

The objective of the “Quick Start Guide” is to get the operator familiarized with key CTS features in a very short time. The “Overview” document provides a brief background on NIST/ITL/CSD support for the development of biometric standards and related technology development efforts. It discusses the need for conformance testing and conformance testing methodology standards development in support of biometric interoperability and data interchange and describes the CBEFF PFA CTS architecture and its functionality.

1.1. Concepts on Conformance Testing

Standards-based conformance testing tools (called Conformance Test Suites in this document) help both developers and users by validating conformance claims, leading to greatly increased levels of confidence in products.

The CTS for Patron Format A data structures specified in ANSI INCITS 398-2008 was developed to determine whether one or more binary file implementations of Biometric Information Records (BIRs) based on this Patron Format conform or not to the standard.

As shown in the diagram below, these binary files are tested against a “Manifest”. A Manifest is a file that defines the format that the binary files must conform to. See the “Overview” document for more information on the required Manifest characteristics.
The CTS uses Test Cases to ensure it operates correctly. A Test Case is a file that contains a Manifest, Binary Data, and the Expected CTS Test Result Information. The Expected Result can be either “Pass” or “Fail for a Specific Reason”. Test Cases are primarily used by the CTS developers. See the “Overview” document for more information on Test Cases. Section 3.2.9.3 of this document discusses how to test and develop Test Cases.

2. Requirements

2.1 Configuration

The CTS has been tested with these operating systems:

- Microsoft Windows® XP Professional Edition
- Microsoft Windows® Vista Ultimate

Recommended minimum display resolution: 1280 X1024 pixels

2.2 CBEFF CTS Beta 1.1 installation

Administrative rights may be required.

1) Download Setup CBEFF CTS Beta 1.1.exe from the CBEFF Patron Format A CTS website:

2) Double-click Setup CBEFF CTS Beta 1.1.exe

3) Follow the installation program instructions.
2.2.1 Location of the Sample Data

The samples files are installed where all computer users can access them.

In Microsoft Windows XP Professional the default location is
C:\Documents and Settings\All Users\Shared Documents\CBEFF CTS Beta 1.1

In Microsoft Windows Vista Ultimate the default location is
C:\Users\Public\Documents\CBEFF CTS Beta 1.1

2.2.2 Location of the Log and Report Files

By default Log and Report Files are saved to the folder
[My Documents]\CBEFF CTS Beta 1.1\Logs

The user can change the folder on the CTS Welcome Window.

2.3 CBEFF_CTS Removal

Administrative rights may be required.

To remove the CBEFF_CTS use Add and Remove Programs in the Control Panel.

2.4 Starting the CBEFF CTS

Select the CBEFF CTS program from the Windows Start menu. The default location is Start | All Programs (or Programs) | CBEFF CTS Beta 1.1 | CBEFF CTS Beta 1.1.

3. CTS Operating Instructions

This Section provides detailed descriptions of all CTS functions, windows, window elements, and main dialogs.
3.1 CBEFF CTS Welcome Window

3.1.1 Title Bar
The title bar displays the CTS name and version number.

3.1.2 Menu Bar
Includes the File and Help menus.

File Menu
Select Exit to close the CBEFF_CTS.

Help menu
Displays a Disclaimer and the Contributors' list (Disclaimer option) and the CTS version (About option)

3.1.3 Log File Prefix and Log Filepath Text Boxes

Enter at least one character (maximum three) in the Log File Prefix text box and click the Apply button before selecting any testing/editing option. This prefix will be the first part of the Test Logs and Test Reports file names. (See section 3.2.2 - Result menu.) This prefix can be changed at any time. The last entry will be used in the file names. This message is displayed if the prefix field is empty when one of the main window testing/editing options is selected.

To change the folder in which the Logs and Reports are saved either enter the folder’s name in the Log File path test box or click the Browse (“…”) button, then click the Apply button.

The three main CTS windows accessed from the Welcome window are:

3.1.4 TestCase/Manifest/BinaryFile Editor

Select this button (#1) in the Welcome window to generate a Manifest, Test Case or Binary file. As stated above, the Manifest is a file that defines the format to which binary files must conform.

This window can also display, edit, test or save files (see Section 3.2).

3.1.5 Test Binary Files

Select this button (#2) to perform conformance testing for Binary files against a Manifest (see Section 3.3). This Manifest could be the sample provided with the CTS, developed by a third party or previously developed by the operator using the CTS or other means.

3.1.6 Check Test Cases

Select this button (#3) to test one or more Test Cases (see Section 3.4).
These windows can also be accessed by clicking the tabs (4) at the bottom of the windows.

3.2 Test Case/Manifest/Binary File Editor Window

Manifests, Test Cases and Binary Files are developed using this window.

3.2.1 Title Bar

The Title bar (1) displays the CBEFF CTS name and version number.

3.2.2 Menu Bar

The Menu bar (2) includes the following options: File, Edit, Result and Help.
**File Menu**

The file menu allows the operator to **Open/Save a Manifest** or **Test Case** (in XML format), **Open/Save a Binary File** and **Save a Biometric Data Block** or a **Security Block** (as binary data).

![File Menu](image)

**Exit** closes the CTS

**Edit menu**

Select **Clear CBEFF Results** to clear the test results.

Select **Clear** to erase all window content.

**Result menu**

Select **Test Log** to display the Test Log.

Select **Test Report** to display the Test Report.

If a test has not been run a warning message will be shown: “A test must be run first before selecting Test Log/Test Report”.

The output of a test is saved as both a Test Log and a Test Report. The Test Log (XML) file is provided for future automated data processing such as importing the results in a data base. The HTML Test Report provides the same information as the Test Log, formatted in human readable form.
The Test Logs and Test Reports are saved into the default or user specified folder. They have the following file name format:

“Log File Prefix_398_2008_PFA_YYYYMMDD_hhmms_RandomNumber”

- Log File Prefix: The one-to-three character field entered in the Prefix window of the Welcome page.
- 398_2008_PFA: Abbreviation of ANSI INCITS 398-2008 Patron Format A.
- YYYYMMDD: Date as year, month and day.
- hhmmss: Time as hour, minute and second.
- Random Number: A three-digit random value

For example, the Test Log file name could be:
“YYL_398_2008_PFA_2008-04-05_154434-718.xml”

The Test Report file name could be:
“YYL_398_2008_PFA_2008-04-05_154612-656.html”.

- **Test Log option**

Select this option to view the Test Log. The Test Log includes the elements shown in this table. A screenshot of this Test Log is shown below.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Manifest, Test Case or Binary (M/TC/B) file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patron Format</td>
<td>In this CTS Beta version: ANSI INCITS 398-2008 – Patron Format A</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Run time (UTC) of the test run.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the M/TC opened in the window</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the M/TC opened in the window to test a M/TC or a Binary file</td>
</tr>
<tr>
<td>File Name</td>
<td>Name of the file that was tested (M/TC/B)</td>
</tr>
<tr>
<td>Expected Result</td>
<td>Can be specified by the user in the Editor window before running the test.</td>
</tr>
<tr>
<td>Number of Fields</td>
<td>Number of fields tested in the record.</td>
</tr>
<tr>
<td>Field Sequence</td>
<td>Field order determined from the file.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Name of the field</td>
</tr>
<tr>
<td>Defined Length</td>
<td>Length specified in the Manifest</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Actual Length</td>
<td>Length of the Binary data which was read as the Actual length</td>
</tr>
<tr>
<td>BytesBase64</td>
<td>MIME base 64 formatted binary data.</td>
</tr>
<tr>
<td>BytesHex</td>
<td>Hexadecimal representation of the binary data</td>
</tr>
<tr>
<td>Test Result verdict</td>
<td>Statement on whether the actual test result is the same as the Expected Result</td>
</tr>
</tbody>
</table>

### Test Report Option

Select this option to view the Test Report. A screenshot of this Test Report is shown below.

Most of the fields in the format are self-explanatory. The Expected Length field (described as Defined Length in the Test Log) and the Length field (described as Actual Length in the Test Log) show the number of bytes. They show any difference
between actual and expected field lengths. The binary content is formatted using MIME base64 and Hexadecimal presentation.

When a Manifest or Test Case is tested the “Name” (e.g., 000_All_fields_pass) and “Description” (Entire-fields-pass) are taken from the Manifest or Test Case. When a Binary file is tested against a Manifest, “Name” and “Description” are taken from the Manifest. “File Name” is the binary file name.

**Help menu**

Displays a Disclaimer and the Contributors’ list (Disclaimer option) and the CTS version (About option)

**3.2.3 Icon Bar**
The Icon bar (#3) provides the same functionality as the Menu bar (see Section 3.2.2), and also includes a “Run” icon. Click the Run Icon to run a test on the selected Manifest, Test Case or Binary file.

### 3.2.4 Name (Manifest/Test Case) and Description Panel

![Name and Description Panel](image)

This Panel (#4) provides the following information:

a) **Name**: Displays and allows editing of the Manifest or Test Case name. This name is included in the Test Log and Test Report generated by testing the Manifest or Test Case. Note: This may be different from the Manifest or Test Case file name.

b) **Description**: This text appears in the Test Log and Test Report. It is highly recommended that this text include high level information on the Manifest or Test Case (e.g., format, author, intended purpose such as “Pass”/”Fail”).

### 3.2.5 Expected Result Panel

![Expected Result Panel](image)

This panel (#5) is used during testing of Test Cases. It also displays information when Manifests and Binary files are tested. The panel consists of the following elements:

a) **Match panel**: Indicates whether there is a match between the Expected Result (“Pass”/”Fail”) and the Actual Result (“Pass”/”Fail”). The window is highlighted in **green** when the results match and in **red** when they don’t.

b) **Expected Result panel**

- When an existing Test Case is loaded, the Expected Result panel indicates whether the Test Case is expected to “Pass” or to "Fail". See a discussion on Test Cases in Section 4.2.1 of the “Overview” document – “Test Case Tester”.

- When developing a Test Case, set the value of the expected result in this panel.

- The Expected Results for all Manifests should be “Pass”.

14
c) Expected Error Info:

- For a Manifest, the data should be as shown in the screenshot above (e.g., Byte Pos equal 0, Field and Error blank).

- For a Test Case that is expected to “Pass”, the Expected Error Information panel should also be as shown in the screenshot above.

- For a Test Case that is expected to “Fail”, this panel displays the exact reason why it is expected to fail.

It is critical to understand the Match Panel to develop Test Cases. As shown below, the Match panel shows the relationship between the Expected Result and the Actual Result when a test is run.

The Match panel is blank when the CTS starts or when the Edit window has been cleared.

The CTS distribution includes a number of Test Cases. All of them “Pass”. Some of them “Pass” because the self contained binary data conform to Patron Format A. “Pass” is indicated by the color green and the word “Match”.

Other Test Cases “Pass” because although the self contained binary data does not conform to the Patron Format, the actual error(s) reported by the CTS matches the expected result (see below).
When there is a mismatch between the Actual Result and the Expected Result the Matching Result will be "Fail". "Fail" is indicated by the color red and the words “No Match”

3.2.6 Fields and Binary Data Panel

This panel (#6) lists the fields of a Manifest or Test Case, and the binary data associated with each field.

a) Field: The ANSI INCITS 398-2008 PFA field names

b) Field number: Below each field is the field sequence number
c) **Len**: Field length in bytes. The Len Input box will be highlighted in yellow if the length is not the same as the number of data bytes.

![Field Length Example](image)

**d) Bytes (Hex)**: The binary data associated with each field in hexadecimal. If the input has a non-hex character, the text color changes to red.

**e) Base and data box**: The base dropdown box displays a user-selectable base (i.e., 2, 8, 10, 16, ASCII). The data box displays the binary data associated with the field in the selected base.

**f) Fields**: Displays the number of fields in the Manifest or Test Case (the number of “fields” includes the BDB and the SB).

**g) Total length**: Displays the sum of the length values of all the fields.

### 3.2.7 Test Panel

The Test Panel (#7) displays the results of the test last run.

When a Test Case or Manifest is tested and no errors are found the panel will display this information.

![Test Results Example](image)

When errors are found, the first of any number of possible errors will be displayed. Clicking the “All Errors” button displays all the errors that were found during the test.

**a) ! Run Test**: Tests the Manifest, Test Case or Binary file in the window.

**b) Actual Result**: Indicates the test result as “Pass”/“Fail”. See also Section 3.2.5.

**c) errorByteArrayPos**: Indicates the error byte position where the error was found.
d) **errorField**: Indicates the Field in which the error was found.

e) **errorNum**: Indicates the Error number and its description.

f) **All Errors**: Displays all the errors that were found during this test and inserts all the errors in the Test Log and Test Report. See Annex A for error message descriptions.

![All Errors](image)

Annex B and C show screenshots of a Test Log and a Test Report that include a list of all the errors encountered by the CTS during a test. When “All Errors” are included in the Test Log and Test Report, they will not show the Test Result verdict on whether the Actual Result is the same than the Expected Result because a failure may have been caused by more than one error. If the test passed, the Test Log and Test Report will show a “Pass” message.

### 3.2.8 Binary Data Panel

This panel (**#8**) displays the concatenated binary data from the Fields and Binary Data panel. The bytes appear in fields sequence order.

![Binary Data](image)

### 3.2.9 Developing Manifests, Test Cases and Binary Files

#### 3.2.9.1 Developing a Manifest

The CTS distribution includes a Manifest named “000_All_fields_pass.xml” that includes all the fields specified in Patron Format A. It is recommended to use this Manifest as the basis for developing other Manifests.

#### 3.2.9.1.1 Making Minor Changes to an Existing Manifest

This clause gives step-by-step instructions for changing the BDB length in an existing Manifest. Similar steps are used to make other minor changes to a Manifest.
1. Open the CTS to the TestCase/Manifest/Binary File Editor window (see Section 3.2)

2. Open the Manifest “000_All_fields_pass.xml”.

3. In the Test panel, click the “! Run Test” button and notice the Manifest passes.

4. Optionally, in the Name and Description panel, change the Name and/or Description.

5. In the Fields and Binary Data panel navigate to the field “BDB_length (11)”.
   Using the “Bytes (Hex)” field enter a different BDB length such as “00 02”.

6. Click the “! Run Test” button and notice the Manifest now fails.

7. Navigate to the field “Biometric_data_block (37)”.
   (a) Using the “Len” field set the length to value entered above in the “BDB_length (11)” field.
   (b) Using the “Bytes (Hex)” field, enter bytes so that the number of bytes corresponds to the new length.

8. Click the “! Run Test” button and notice the Manifest now passes.

9. Optionally, save the Manifest.

3.2.9.1.2 Developing a Manifest from Scratch

1. Prepare a list of the fields the Manifest will contain. The list should include the field names, their length in bytes, and an example of valid binary data (in hexadecimal notation) for each field.

2. Open the CTS to the TestCase/Manifest/Binary File Editor window (see Section 3.2).

3. If the Editor window contains data, from the “Edit” menu select “Clear” to erase the window.

4. In the Name and Description panel, enter a suitable “Name” and “Description” for the Manifest.

5. In the Expected Result panel, ensure the Expected Result is “Pass”.

6. In the Fields and Binary Data panel, set “Fields” to the number of fields the Manifest will contain.

7. In the Fields and Binary Data panel, for each field the Manifest is to contain:
(a) Using the “Field” dropdown box, select the Field name for that position in the Manifest.

(b) Using the “Len” field, set the byte length of the field.

(c) Using the "Bytes (Hex)" field, enter the valid sample hexadecimal data for that field.

(d) To save or resave the Manifest at any time, from the “File” menu select “Save Manifest…”

8. When the fields have been entered it is recommended that the Manifest be saved.

9. In the Test panel, click the “! Run Test” button. If an error occurs, correct the error in the corresponding field in the Fields and Binary Data panel, and click the “! Run Test” button again. Repeat this process until all errors have been corrected.

10. Save the Manifest.

3.2.9.1.3 Developing a Manifest by Editing the XML Directly

A Manifest is an XML file and in some cases it is convenient to use an editor such as Notepad while developing a manifest. Examples include moving a misplaced field to its proper location and deleting an unneeded field. This clause gives step-by-step instructions for switching the order of the first two fields and duplicating the third field using Notepad on a copy of an existing Manifest.

1. In Windows Explorer, select the Manifest “000_All_fields_pass.xml”.

2. From the “Edit” menu select “Copy”.

3. From the “Edit” menu select “Paste”.

4. Using Notepad, open this new copy of the Manifest.

5. Change `<NumberOfFields>38</NumberOfFields>` to `<NumberOfFields>39</NumberOfFields>`

6. Select this text:
   `<Field Sequence="1" Name="SBH_patron_format_owner" DefinedLength="2" ActualLength="2" BytesBase64="ABs=" Hex="001B" />`

7. From the “Edit” menu select “Cut”.

8. From the “Edit” menu select “Paste”.

9. Change `<NumberOfFields>38</NumberOfFields>` to `<NumberOfFields>39</NumberOfFields>`

10. Save the Manifest.
8. Insert a blank line after this line:
  <Field Sequence="2" Name="SBH_patron_format_type" DefinedLength="2"
  ActualLength="2" BytesBase64="AAE=" Hex="0001" />

9. Position the cursor on this blank line, then from the “Edit” menu select “Paste”.

10. Use similar editing commands to duplicate the third field. The first four fields
    should now be like this:
    <Field Sequence="2" Name="SBH_patron_format_type" DefinedLength="2"
    ActualLength="2" BytesBase64="AAE=" Hex="0001" />
    <Field Sequence="1" Name="SBH_patron_format_owner" DefinedLength="2"
    ActualLength="2" BytesBase64="ABs=" Hex="001B" />
    <Field Sequence="3" Name="BDB_format_owner" DefinedLength="2"
    ActualLength="2" BytesBase64="AAE=" Hex="0001" />
    <Field Sequence="3" Name="BDB_format_owner" DefinedLength="2"
    ActualLength="2" BytesBase64="AAE=" Hex="0001" />

11. Update the “Sequence” values.
    <Field Sequence="1" Name="SBH_patron_format_type" ...
    <Field Sequence="2" Name="SBH_patron_format_owner" ...
    <Field Sequence="3" Name="BDB_format_owner" ...
    <Field Sequence="4" Name="BDB_format_owner" ...
    <Field Sequence="5" Name="BDB_format_type" ...
    <Field Sequence="6" Name="Product_format_owner" ...
    <Field Sequence="7" Name="Product_format_type" ...
    <Field Sequence="8" Name="Device_format_owner" ...
    <Field Sequence="9" Name="Device_format_type" ...
    <Field Sequence="10" Name="Record_attributes" ...
    <Field Sequence="11" Name="SBH_length" ...
    ...

12. From the “File” menu select “Save”.

13. Open the CTS to the TestCase/Manifest/Binary File Editor window (see
    Section 3.2 and the window screenshot).

14. Open the Manifest created in the above steps and note the reversed and
    duplicated fields.

3.2.9.2 Developing a Binary File

Developers may use the CTS to easily develop sample binary files similar to the
ones that will be generated by a product.

An effective way to develop a sample binary file is to start from a Manifest, make any
needed changes to the Manifest’s binary data, and then save the changed binary
data to a binary file. The step-by-step instructions below describe how to do this. Note that this example produces an invalid binary file.

1. Open the CTS to the TestCase/Manifest/Binary File Editor window (see Section 3.2).

2. Open the Manifest named “000_All_fields_pass.xml”.

3. Click the “! Run Test” button in the Test panel to test this Manifest with its binary data. Notice that the test passes, indicating that this is a valid Manifest.

4. In the Binary Data panel, note that the first two bytes displayed are “00 1B”.

5. In the Fields and Binary Data panel, change the Bytes in Field 1, SBH_patron_format_owner (1), from “00 1B” to any other value such as “00 1C” or “FF FF”.

6. In the Binary Data panel, note the first two bytes have changed to correspond to the changes made in the previous step.

7. Click the “! Run Test” button in the Test panel and notice the error information in the panel.

8. Optionally, from the “File” menu select “Save Binary File…” to save the binary file.

### 3.2.9.3 Testing and Developing Test Cases

A user may not need to develop Test Cases since the primary use of them is to test the CTS. However this CTS allows the user to either test existing Test Cases (provided in the distribution) or to develop their own.

This clause gives step-by-step instructions for testing an existing Test Case and for creating a Test Case that verifies that an incorrect value in the SBH Patron Format Owner field does not pass. The same procedure can be used to modify an existing Test Case or to create these Test Cases to test the CTS for a specific set of PFA fields.

1. Open the CTS to the TestCase/Manifest/Binary File Editor window (see Section 3.2).

2. Open the Test Case named “000_All_fields_pass.xml”

3. In the Test panel, click the “! Run Test” button to verify that this Test Case passes. This is the procedure to perform a test of an existing Test Case.

4. In the Name and Description panel, change the Name to, for example: “Field_01_Bad_PFO_Value_Fails”.

22
5. Change the Description to “Tests that have an invalid value for field 1, SBH Patron Format Owner do not pass.”

6. In the Expected Result panel, change the Expected Result to “Fail”.

7. In the Fields and Binary Data panel, change the Bytes in Field 1, SBH_patron_format_owner (1), from “00 1B” to any other value such as “00 1C” or “FF FF”.

8. In the Test panel click the “! Run Test” button and notice the error information in the panel. Note that although the Test Case is expected to “Fail”, the Match panel is highlighted in red. This is because the Expected Error Information does not match the Actual Results. See Section 3.2.5.

9. In the Expected Result panel, set the Expected Error Information to the same values displayed in the “Test” panel:

   (a) Enter into “Byte Pos” the value displayed in “errorByteArrayPos”.

   (b) Using the “Field” dropdown box, select the Field name displayed in “errorField”.

   (c) Using the “Error” dropdown box, select the error number displayed in “errorNum”.

10. Click the “! Run Test” button. Note that the Match panel in the Expected Result panel indicates success since the Expected Results are the same as the Actual Results. The Test Case is complete, as the CTS verifies that an incorrect SBH Patron Format Owner does not pass.

11. Optionally, save the Test Case.

### 3.2.9.4 Testing Binary files

Binary files are tested in the “Test Binary File” window. This window is read-only; binary files are not changed.

#### 3.3 Test Binary Files Window

See a screenshot of the window in the following page.
3.3.1 Title Bar

The title bar displays the CTS name and version number.

3.3.2 Menu Bar

Includes the following options: File, Run, Edit, Result and Help.

*File menu*
These options allow the operator to choose a Manifest or a Binary file or close the CTS.

**Run menu:**
Select this option to test Binary files against a Manifest.

**Edit menu**
Select this option to clear the window.

**Result menu**

![Menu Options]

The Result menu is used to display the Test Log and/or the Test Report. The binary file names are included in the Test Log and Report. Examples of a Test Log and a Test Report are shown in Section 3.2.2. These Logs and Reports have the same format for both Manifest and Test Case testing.

Test Logs and Test Reports generated during Binary file testing also have the same formats as above with the exceptions of “TestSuite Type” which is “Binary” and the “File Name” which is the name of the binary file tested.

**Help menu**
Displays a Disclaimer and the Contributors’ list (Disclaimer option) and the CTS version (About option)

### 3.3.3 Icon bar

- **Manifest icon:** Click to select an existing Manifest.
- **Binary file icon:** Click to select one or more Binary files.
- **Run icon:** Click to start the test of the selected Binary files against the selected Manifest.
- **Log Icon:** Click to display the Test Log.
- **Reports Icon:** Click to display the Test Report.
• **C Icon:** Click to clear the window.

• **CR Icon:** Click to clear the results.

### 3.3.4 Manifest Open panel

This panel displays the name of the Manifest that will be used to test a binary file or set of binary files.

![Manifest](image)

### 3.3.5 Testing Binary Files

1. Choose a Manifest. In normal use it is expected that this would be a “valid” Manifest for the binary files to be tested.

2. Choose a Binary file or a set of Binary files. The file name(s) will be displayed in the Binary Files window.

3. Run the test.

One of the following Status Indicators associated with each binary file selected will display one of the colors shown below:

- **Yellow:** The result is undecided.
- **Green:** The test passed.
- **Red:** The test failed.
4. Test results are written to a Test Log and a Test Report. The Test Log and Test Report include information on all the Test Cases concurrently tested.

Double-click a Binary File name to open the Binary File and Manifest in the Test Case/Manifest/Binary File Editor window (see Section 3.2).

**3.3.6 Test Status Panel**

- **Numerical results:**
  - **Runs:** Total number of tests run.
- **Pass**: the number of tests that passed.
- **Fail**: the number of tests that failed

### 3.4 Check Test Cases Window

This window is used to test Test Cases. A number of Test Cases are included in the CTS distribution. See Section 2.2.1 for sample data location.

#### 3.4.1 Title Bar

The title bar displays the CTS name and version number.

#### 3.4.2 Menu Bar

Includes the following options: File, Run, Edit, Result and Help.
**File menu**

These options allow the operator to choose one or more Test Cases or close the CTS.

**Run menu:**

Select this option to test the selected Test Cases.

**Edit menu**

Select this option to clear the window.

**Result menu**

The Result menu is used to display the Test Log and the Test Report (see Section 3.2.2).

**Help menu**

Displays a Disclaimer and the Contributors’ list (Disclaimer option) and the CTS version (About option).

### 3.4.3 Icon Bar

- **TCs Icon:** Click to open a Test Case or a set of Test Cases.
- **Run Icon:** Click to test the selected Test Cases.
- **Log Icon:** Click to view the Test Log.
- **Report Icon:** Click to view the Test Report.

The Test Log and Test Report include information on all the Test Cases concurrently tested.

- **C Icon:** Click to clear the window.
- **CR Icon:** Click to clear the results.

### 3.4.4 Test Case Panel
Indicates whether the actual results match the expected results. The Status Indicators display one of these colors:

- **Yellow**: The result is undecided.
- **Green**: The test passed.
- **Red**: The test failed.

3.4.5 Test Status Panel

![Test Cases]

- **Numerical results**: see Section 3.3.6.

3.4.6 Test Case Analysis

Double-click a Test Case to open it in the Test Case/Manifest/Binary File Editor window.
Annex A. List of Error Messages

There are a number of errors that can be encountered while running a test. They are related to the following:

a) errors found in Mandatory fields
b) errors found in Conditional and Optional fields
c) errors derived from an incorrect relationship between fields (e.g., Record Attributes – SBH Length value & SBH # of bytes)
d) errors derived from other required missing relationships between fields (e.g., FO/FT, creator content subfield vs. creator length subfield missing)

Table A.1 – List of Error Messages

<table>
<thead>
<tr>
<th>Num</th>
<th>Error Name</th>
<th>Code</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ERR_NO_BYTES</td>
<td>101</td>
<td>Manifest, Test Case or Binary file testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No bytes were found</td>
</tr>
<tr>
<td>2</td>
<td>ERR_UNDEFINED_FIELD</td>
<td>102</td>
<td>Manifest or Test Case testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Undefined field name</td>
</tr>
<tr>
<td>3</td>
<td>ERR_TOO_FEW_BYTES</td>
<td>103</td>
<td>Manifest or Test Case testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The field length is greater than the number of bytes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Binary File testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The number of bytes in the binary file is less than the number of bytes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>specified in the manifest.</td>
</tr>
<tr>
<td>4</td>
<td>ERR_TOO_MANY_BYTES</td>
<td>104</td>
<td>Manifest or Test Case testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The field length is less than the number of bytes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Binary File testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The number of bytes in the binary file is greater than the number of</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>bytes specified in the manifest.</td>
</tr>
<tr>
<td>5</td>
<td>ERR_TOO_FEW_FIELD_BYTES</td>
<td>105</td>
<td>Manifest or Test Case testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The number of bytes in the field under test is less than the number</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>of bytes specified in the standard for the field.</td>
</tr>
<tr>
<td>6</td>
<td>ERR_TOO_MANY_FIELD_BYTES</td>
<td>106</td>
<td>Manifest or Test Case testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The number of bytes in the field under test is greater than the number</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>of bytes specified in the patron format for the field.</td>
</tr>
<tr>
<td>7</td>
<td>ERR_UNKNOWN_VALUE</td>
<td>107</td>
<td>Manifest, Test Case or Binary file testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>An unknown or incorrect value was found in the field under test.</td>
</tr>
<tr>
<td>8</td>
<td>ERR_DUPLICATE_FIELD</td>
<td>108</td>
<td>Manifest or Test Case testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A duplicate field has been found in a test case or manifest under test.</td>
</tr>
<tr>
<td>9</td>
<td>ERR_MANDATORY_FIELD_MISSING</td>
<td>109</td>
<td>Manifest or Test Case testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A mandatory field was not found in the manifest or test case.</td>
</tr>
<tr>
<td>10</td>
<td>ERR_BDB_MISSING_IN_RECORD</td>
<td>110</td>
<td>Manifest, Test Case testing:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The BDB is missing.</td>
</tr>
<tr>
<td>Num</td>
<td>Error Name</td>
<td>Code</td>
<td>Comment</td>
</tr>
<tr>
<td>-----</td>
<td>-----------------------------------------------</td>
<td>------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>11</td>
<td>ERR_SB_MISSING_IN_RECORD</td>
<td>111</td>
<td>Manifest or Test Case testing: The SB length field in the manifest or test case indicates that the SB must be present but it is missing.</td>
</tr>
<tr>
<td>12</td>
<td>ERR_FIELD_ORDER</td>
<td>112</td>
<td>Manifest or Test Case testing: Mandatory, conditional or optional fields are out of sequence.</td>
</tr>
<tr>
<td>13</td>
<td>ERR_PAIR_SBH_PATRON_FT_OWNER</td>
<td>201</td>
<td>Manifest or Test Case testing: SBH Patron Format Owner subfield is missing.</td>
</tr>
<tr>
<td>14</td>
<td>ERR_PAIR_SBH_PATRON_FT_TYPE</td>
<td>202</td>
<td>Manifest or Test Case testing: SBH Patron Format Type subfield is missing.</td>
</tr>
<tr>
<td>15</td>
<td>ERR_PAIR_BDB_FT_OWNER</td>
<td>203</td>
<td>Manifest or Test Case testing: The BDB Format Owner subfield is missing.</td>
</tr>
<tr>
<td>16</td>
<td>ERR_PAIR_BDB_FT_TYPE</td>
<td>204</td>
<td>Manifest or Test Case testing: The BDB Format Type subfield is missing.</td>
</tr>
<tr>
<td>17</td>
<td>ERR_PAIR_PRODUCT_FT_OWNER</td>
<td>205</td>
<td>Manifest or Test Case testing: The Product Format Owner subfield is missing.</td>
</tr>
<tr>
<td>18</td>
<td>ERR_PAIR_PRODUCT_FT_TYPE</td>
<td>206</td>
<td>Manifest or Test Case testing: The Product Format Type subfield is missing.</td>
</tr>
<tr>
<td>19</td>
<td>ERR_PAIR_DEVICE_FT_OWNER</td>
<td>207</td>
<td>Manifest or Test Case testing: The Device Format Owner subfield is missing.</td>
</tr>
<tr>
<td>20</td>
<td>ERR_PAIR_DEVICE_FT_TYPE</td>
<td>208</td>
<td>Manifest or Test Case testing: The Device Format Type subfield is missing.</td>
</tr>
<tr>
<td>21</td>
<td>ERR_PAIR_SB_FT_OWNER</td>
<td>209</td>
<td>Manifest or Test Case testing: The Security Block Format Owner subfield is missing.</td>
</tr>
<tr>
<td>22</td>
<td>ERR_PAIR_SB_FT_TYPE</td>
<td>210</td>
<td>Manifest or Test Case testing: The Security Block Format Type subfield is missing.</td>
</tr>
<tr>
<td>23</td>
<td>ERR_PAIR_NL_PATRON_FT_OWNER</td>
<td>211</td>
<td>Manifest or Test Case testing: The NL Patron Format Owner subfield is missing.</td>
</tr>
<tr>
<td>24</td>
<td>ERR_PAIR_NL_PATRON_FT_TYPE</td>
<td>212</td>
<td>Manifest or Test Case testing: The NL Patron Format Type subfield is missing.</td>
</tr>
<tr>
<td>25</td>
<td>ERR_PAIR_DQ_ALGORITHM_OWNER</td>
<td>213</td>
<td>Manifest or Test Case testing: The DQ algorithm Owner subfield is missing.</td>
</tr>
<tr>
<td>26</td>
<td>ERR_PAIR_DQ_ALGORITHM_TYPE</td>
<td>214</td>
<td>Manifest or Test Case testing: The DQ algorithm Type subfield is missing.</td>
</tr>
<tr>
<td>27</td>
<td>ERR_PAIR_CREATOR_LENGTH</td>
<td>215</td>
<td>Manifest or Test Case testing: The Creator Length subfield is missing.</td>
</tr>
<tr>
<td>28</td>
<td>ERR_PAIR_CREATOR_CONTENT</td>
<td>216</td>
<td>Manifest or Test Case testing: The Creator Content subfield is missing.</td>
</tr>
<tr>
<td>Num</td>
<td>Error Name</td>
<td>Code</td>
<td>Comment</td>
</tr>
<tr>
<td>-----</td>
<td>----------------------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>29</td>
<td>ERR_PAIR_CR_LENGTH</td>
<td>217</td>
<td><strong>Manifest or Test Case testing:</strong> The Challenge Response Length subfield is missing.</td>
</tr>
<tr>
<td>30</td>
<td>ERR_PAIR_CR_CONTENT</td>
<td>218</td>
<td><strong>Manifest or Test Case testing:</strong> The Challenge Response Content subfield is missing.</td>
</tr>
<tr>
<td>31</td>
<td>ERR_PAIR_PAYLOAD_LENGTH</td>
<td>219</td>
<td><strong>Manifest or Test Case testing:</strong> The Payload Length subfield is missing.</td>
</tr>
<tr>
<td>32</td>
<td>ERR_PAIR_PAYLOAD_CONTENT</td>
<td>220</td>
<td><strong>Manifest or Test Case testing:</strong> The Payload _Content subfield is missing.</td>
</tr>
<tr>
<td>33</td>
<td>ERR_PAIR_BIOMETRIC_DQ_VALUE</td>
<td>221</td>
<td><strong>Manifest or Test Case testing:</strong> The Biometric Data Quality Value subfield is missing.</td>
</tr>
<tr>
<td>34</td>
<td>ERR_PAIR_DQ_ALGORITHM_IDEN</td>
<td>222</td>
<td><strong>Manifest or Test Case testing:</strong> The DQ Algorithm Owner and Type subfields are missing.</td>
</tr>
<tr>
<td>35</td>
<td>ERR_INVALID_OPT_FIELD_PRE</td>
<td>301</td>
<td><strong>Manifest, Test Case or Binary file testing:</strong> An optional field that is present in the manifest, test case or binary file is not identified in the Optional Field Present Mask.</td>
</tr>
<tr>
<td>36</td>
<td>ERR_RS_PERIOD_FIR_SEC</td>
<td>302</td>
<td><strong>Manifest, Test Case or Binary file testing:</strong> The Validity Period field date relationship (not before through not after) is incorrect.</td>
</tr>
<tr>
<td>37</td>
<td>N/A</td>
<td>303</td>
<td>N/A</td>
</tr>
<tr>
<td>38</td>
<td>ERR_RS_CREATOR_CONTENT_LEN</td>
<td>304</td>
<td><strong>Manifest, Test Case or Binary file testing:</strong> There is a relationship conflict between the Creator length field value and the length of the Creator content field.</td>
</tr>
<tr>
<td>39</td>
<td>ERR_RS_CR_CONTENT_LENGTH</td>
<td>305</td>
<td><strong>Manifest, Test Case or Binary file testing:</strong> There is a relationship conflict between the Challenge Response Length field value and the length of the Challenge_response content field.</td>
</tr>
<tr>
<td>40</td>
<td>ERR_RS_PAYLOAD_CONTENT_LEN</td>
<td>306</td>
<td><strong>Manifest, Test Case or Binary file testing:</strong> There is a relationship conflict between the Payload Length field value and the length of the Payload Content field.</td>
</tr>
<tr>
<td>41</td>
<td>ERR_RS_OPTIONAL_FIELD_MISSI</td>
<td>307</td>
<td><strong>Manifest or Test Case testing:</strong> An optional field marked present in the Optional Fields Present Mask field is missing.</td>
</tr>
<tr>
<td>42</td>
<td>ERR_RS_SBH_LENGTH_TOTAL_LEN</td>
<td>308</td>
<td><strong>Manifest or Test Case testing:</strong> The length value in the SBH Length field is different than the total length of the SBH (based on the length of each SBH field indicated in the Manifest or Test Case). Binary file testing: See Note 1.</td>
</tr>
<tr>
<td>Num</td>
<td>Error Name</td>
<td>Code</td>
<td>Comment</td>
</tr>
<tr>
<td>-----</td>
<td>------------------------------------------------</td>
<td>------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>43</td>
<td>ERR_RS_BDB_LENGTH_BDB</td>
<td>309</td>
<td><strong>Manifest or Test Case testing:</strong> The length value in the BDB Length field is different than the length of the BDB (based on the BDB length indicated in the Manifest or Test Case). <strong>Binary file testing:</strong> See Note 1.</td>
</tr>
<tr>
<td>44</td>
<td>ERR_RS_SB_LENGTH_SB</td>
<td>310</td>
<td><strong>Manifest or Test Case testing:</strong> The length value in the SB Length field is different than the length of the SB (based on the SB field length indicated in the Manifest or Test Case). <strong>Binary file testing:</strong> See Note 1.</td>
</tr>
<tr>
<td>45</td>
<td>ERR_RS_MISMATCH_WITH REC_ATT_MASK</td>
<td>311</td>
<td>Mismatch between the Record Attributes field mask and the SBH/BDB/ SB Length.</td>
</tr>
<tr>
<td>46</td>
<td>ERR_RS_INCORRECT_FIELD_PRESENT</td>
<td>312</td>
<td><strong>Manifest or Test Case Testing:</strong> Incorrect relationship between the SB Length field value and presence/absence of the SB FO/FT and/or the SB.</td>
</tr>
<tr>
<td>47</td>
<td>ERR_RS_BDB_LENGTH_SUB_HEADER</td>
<td>313</td>
<td>Incorrect relationship between the BDB Length field value and the Subheader Count field value.</td>
</tr>
</tbody>
</table>

**Note 1:** Although supported by the CTS architecture, this version of the CTS is released only with a SBH PFA testing module. It does not include modules (under development) to test BDBs or SBs. Therefore, this CTS is not able to detect the errors in the boundary between the BDB and the SB.
Annex B. Test Log Displaying “All Errors” Information
Annex C. Test Report Displaying “All Errors” Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Error Count</th>
<th>Error Position</th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>6</td>
<td>107: ERR_UNKNOWN_VALUE</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>6</td>
<td>107: ERR_UNKNOWN_VALUE</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>6</td>
<td>107: ERR_UNKNOWN_VALUE</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>6</td>
<td>107: ERR_UNKNOWN_VALUE</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>6</td>
<td>107: ERR_UNKNOWN_VALUE</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>6</td>
<td>107: ERR_UNKNOWN_VALUE</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>6</td>
<td>107: ERR_UNKNOWN_VALUE</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>6</td>
<td>107: ERR_UNKNOWN_VALUE</td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>6</td>
<td>107: ERR_UNKNOWN_VALUE</td>
</tr>
</tbody>
</table>

Error Codes:
- 1: SIDH_pattern_format_owner
- 2: RDB_format_owner
- 3: Product_format_owner
- 4: Optional_present_mask
- 5: SIDH_length

Error Messages:
- 107: ERR_UNKNOWN_VALUE
Annex D. IBIA Identifiers

The IBIA identifiers for Patron Format Owner, BDB Format Owner, Product Owner, Device Owner, Security Block Format Owner and Quality Algorithm Owner are in the text file:

ValidBdbFormatOwners.txt

It is in the CTS installation folder. The default folder is

C:\Program Files\CBEFF CTS Beta 1.1\ValidBdbFormatOwners.txt


To add an IBIA identifier, modify the file in a text editor such as Notepad. The required format is documented in the file. (Note that this is not an IBIA registration procedure.)